The Nihongo tutorial system is an intelligent tutorial system designed to use a computer to assist scientists and engineers in developing reading competence in technical Japanese. It consists of three applications: the Nihongo Tutor, which provides useful information about an article (translation, syntax, pronunciation) to help understand the text of a personalized lesson, and records student performance; the Parse Tree Editor, used to prepare technical articles for the tutorial system; and the Administrator, which uses student data to assign an article that is technically and pedagogically appropriate. The program integrates the three functions. The user's guide, presented here, gives an overview of each function and offers specific directions for its use. The section on the Administrator provides guidelines for article selection and system files management. The Nihongo Tutor's guide discusses text editing, display, and comprehension and the use of the electronic dictionaries incorporated in the software. Instructions for use of the Parse Tree Editor also discuss text editing and display and proceed to construction of a parse tree, retrieval of information, and modification of translation information for an article. The text is illustrated with screens. (MSE)
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>CHAPTER</th>
<th>INTRODUCTION</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHAPTER</th>
<th>ADMINISTRATOR USER'S GUIDE</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>II</td>
<td>2.1 Overview</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>2.2 Article Selection</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>2.3 System Files Management</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHAPTER</th>
<th>NIHONGO TUTOR USER'S GUIDE</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>III</td>
<td>3.1 Overview</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>3.2 Text Editing</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>3.3 Text Display</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>3.4 Text Comprehension</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>3.5 Electronic Dictionaries</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHAPTER</th>
<th>PARSE TREE EDITOR USER'S GUIDE</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>IV</td>
<td>4.1 Overview</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>4.2 Text Editing</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>4.3 Text Display</td>
<td>66</td>
</tr>
<tr>
<td></td>
<td>4.4 Constructing a Parse Tree</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>4.5 Retrieving Information</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>4.6 Modifying Translation Information</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td></td>
<td>56</td>
</tr>
</tbody>
</table>
CHAPTER I - INTRODUCTION

The Nihongo tutorial system presented here is an intelligent tutorial system designed to use a computer to assist scientists and engineers in developing reading competence in technical Japanese. It is comprised of three applications: the Nihongo Tutor, the Parse Tree Editor and the Administrator. The Nihongo Tutor provides useful information about an article, such as an English translation, syntax and pronunciation, to help the student to comprehend the text of a personalized lesson. It also records the student's performance into his personal database which reflects his current Japanese language proficiency. The Administrator uses the personal data of a student to assign an article that is related to his technical interests and at his current level of Japanese competence. The Parse Tree Editor is used to prepare technical articles for the tutorial system by incorporating semantic, syntactic, phonetic and morphological information into the parse tree of a sentence in each article.

The tutorial system is structured to work in an operational model that integrates the functions of the three applications together. The model is composed of three phases: text preparation, article selection and text comprehension. These phases are performed by the Parse Tree Editor, the Administrator, and the Nihongo Tutor respectively. The Administrator and the Nihongo Tutor form the management system for the tutorial system since they record the progress of the student and store other information that aids in determining the next lesson for the student.
Description of the Operational Model

Figure 1 presents the operational model for the Nihongo tutorial system. The dashed lines in figure 1 reveal the interaction between the applications. The model shows how a student goes through the process of studying an article by using the tutorial system. A typical user of the tutorial system has to go through the article selection and text comprehension phases repetitively. However, he does not need to be concerned about the text preparation phase since it should be managed by the system supervisor.

Article Selection

The Administrator receives personal information about each student from the Nihongo Tutor and selects a technical article for the student as the next lesson. This article must conform with the student's technical interests (or profession) and his current Japanese language proficiency. The Administrator searches through the list of articles prepared using the Parse Tree Editor until it finds an article that is appropriate for the student. The searching algorithm is based on matching the lexemes of each article with the student's competence information stored in his personal database. Since the task of article selection is personalized, each student has a unique password in order to access and use the Administrator. Once the Administrator succeeds in making an assignment, it informs the Nihongo Tutor about the article name so that the tutor can choose the right article for the student to study.
Figure 1. Operational Model of the Nihongo Tutorial System
In summary, the functions of the Administrator are as follows:

- select a technical article for the student based on his current Japanese competence and technical interests,
- inform the Nihongo Tutor about the lesson assigned,
- receive student information from the Nihongo tutor and use it for article selection.

Text Comprehension

Whenever a student logs on to the Nihongo Tutor, he must provide his user name so that the tutor can retrieve the article assigned by the Administrator as his lesson. If the student needs help while studying an article, he can use the translation facilities provided by the Nihongo Tutor. If the tutor provides translation information or readings, it will update the student's personal database to record which material he has had difficulty comprehending. As a result, the student's database will reflect his current Japanese language proficiency. Once the student finishes studying an article, he should use the Administrator again to select the article for his next lesson.

In summary, the functions of the Nihongo Tutor are as follows:

- provide technical articles (which are prepared using the Parse Tree Editor) for the student to study,
- assist the student in studying Japanese articles by providing useful translation facilities,
- update the student personal database (which reflects his current Japanese competence) to be used by the Administrator for article selection.
Text Preparation

The tutorial system must be able to provide a large number of articles categorized under different technical disciplines so that each student can study articles that are related to his own profession. It is the task of the Parse Tree Editor to prepare these technical articles by transforming useful information about each article into an internal format that can be utilized by the Nihongo Tutor and the Administrator. In particular, it incorporates the semantic, syntactic and phonetic information into an augmented parse tree of each sentence in an article. It also keeps the lexemes of each sentence in a list so that the Administrator can compare them with the information stored in the student's database during the article selection phase.

In summary, the functions of the Parse Tree Editor are as follows:

- prepare technical articles (in an internal format) for the tutorial system,
- provide translation information (semantic, syntactic and phonetic) about each article for the Nihongo Tutor,
- provide lexical information (lexemes) about each article for the Administrator.
CHAPTER II - ADMINISTRATOR USER'S GUIDE

The Administrator is an application designed to do the following:

- select an article based on the user's current Japanese language competence and his technical interests
- access and update system files

The privilege of managing system files is limited to the system supervisor. The following sections give descriptions about the functions of the Administrator as well as some examples for illustration. Notes are given at points that need special attention.
2.1 Overview

The Administrator provides three menus for the user as well as a special menu, called the "Database" menu, for the system supervisor. A typical user will find himself using the "File" menu most of the time. The main menus are as follows:

**Apple Menu.** The apple menu allows the user to select one of the standard desk accessories available from the Macintosh system.

**File Menu.** The file menu allows the user to select an article based on his current Japanese language competence and technical interests. This menu contains one single command, called "Enter Username", which is used to retrieve the article assigned to a user to study.

Note: The "Database" menu can be accessed by entering the special password reserved for the system supervisor.

**Edit Menu.** The edit menu allows the user to do standard text editing. This menu is currently disabled.

**Database Menu.** This menu provides the system supervisor with useful facilities for updating system files. This menu is usually invisible for the typical user. A special password must be entered before this menu can be used. The commands that this menu contains, as shown in figure 2, are as follows:

- **Technical Field**
  
  Access and update records in the "Technical fields" file that keeps information about the list of technical articles available in the system.

- **User Record**
  
  Access and update records in the "Users" file that keeps information about each individual user of the system.
Figure 2. The Database Menu
— User Selection

Access and update records in the "User Selection" file that keeps information about the technical articles assigned to the users.

— User Database

Access and update records in a user's personal database file that keeps information about what a user currently does and does not know.
2.2 Article Selection

The Administrator selects an article for a user based on his current Japanese competence and his technical interests. The first time that a new user uses the Nihongo tutorial system, he will be requested to select a technical area so that articles in this area can be assigned for him to study. If the user has already used the system, new technical articles will be assigned according to his current Japanese language competence.

The following examples describe the steps necessary to use the Administrator to select articles as a new or old user.

Example 1. Selecting an Article as a New User

(a) Choose “Enter UserName” from the “File” menu. Enter the user name and click the Ok button (see figure 3).

(b) A dialog box then appears showing all the main technical topics available. The user should click the Down-Level button to obtain more information about the sub-topics of a main topic. The Up-Level button can be clicked to obtained more information about the main topic of a sub-topic. Once a specific technical area is selected, the Ok button should be clicked. As a new user, the user will be assigned the first article as an introductory lesson (see figure 4).
(a) Choose "Enter UserName"

(b) Enter user name

Figure 3. An Example of Selecting an Article as a New User
(a) Investigate sub-topics

- Physics
- Others

(b) Select a technical area

- Kinematics
- Kinetics
- Others

(c) An article assigned

You will have an article in the area Kinetics starting with the first level.

Figure 4. Selecting a Technical Area of Interest
Example 2. Selecting an Article as an Old User

After entering the user name, the user will be prompted to confirm his technical area of interest as an old user.

(a) If the user intends to keep his technical area of interest, he should click the Ok button and the Administrator will attempt to search for an article in this area that matches his current Japanese language proficiency (see figure 5). There will be a comparison between the material stored in his personal database and that of the technical articles to find an article at the appropriate level of difficulty. If the user does not want to study the article assigned by the Administrator, he can manually override the assignment by clicking the Down-Level or Up-Level button to get other articles that are easier or more difficult than the current one.

(b) If the user wants to change his technical areas of interest, he can do so by clicking the No button. The system will then go through the process of selecting an article in a new technical area as outlined in example 1.
Your area of interest is Kinetics. Do you want to keep it?!

(a) Confirm the technical area

User Information: Nelson Leung

Technical Area: Kinetics
Article Area: Kinetics
Last File of Access: Kinetics1
Last Time of Access: 1990年1月21日 2:31 PM

<table>
<thead>
<tr>
<th>Article File</th>
<th>Kinetics1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Known area</td>
<td>57%</td>
</tr>
<tr>
<td>Review area</td>
<td>30%</td>
</tr>
<tr>
<td>New area</td>
<td>12%</td>
</tr>
</tbody>
</table>

(b) Comparison of personal database with article material

Figure 5. An Example of Selecting an Article as an Old User
2.3 System Files Management

The system supervisor has the special privilege of accessing and updating system files by using commands available in the "Database" menu. There are four different types of system files that keep important information about the tutorial system. The content of these files are as follows:

— Technical Fields

Information about articles available in each technical area and the relationship between the main topics and sub-topics.

— User Record

Information about each individual user such as his technical interests, the article name of his last lesson, etc (see figure 6).

— User Selection

Information about the current articles assigned to the users (see figure 7).

— User Database

Information about the current Japanese language proficiency of a user. The supervisor can enter a user's name in order the access his database file. The information is stored in two areas: the Well-known area and the Unfamiliar area (see figure 8).

Note: The user database file is also automatically manipulated by the Nihongo Tutor.
<table>
<thead>
<tr>
<th>User Record Information</th>
<th>Current Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Nelson Leung</td>
<td>Nelson Leung</td>
</tr>
<tr>
<td>Technical Area</td>
<td>Kinetics</td>
<td>Kinetics</td>
</tr>
<tr>
<td>Article Area</td>
<td>Kinetics</td>
<td>Kinetics</td>
</tr>
<tr>
<td>Last access file</td>
<td>Kinetics1</td>
<td>Kinetics1</td>
</tr>
<tr>
<td>Last access time</td>
<td>1990年2月9日 5:07</td>
<td>Current Time</td>
</tr>
</tbody>
</table>

Figure 6. A Record of the User Record File
<table>
<thead>
<tr>
<th>User Selection Information</th>
<th>Current Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Nelson Leung</td>
<td>Nelson Leung</td>
</tr>
<tr>
<td>Article File</td>
<td>Kinetics1</td>
<td>Kinetics1</td>
</tr>
</tbody>
</table>

Figure 7. A Record of the User Selection File
Figure 8. The Records of a User Database File
Using the commands available in the "Database" menu, the supervisor can retrieve records in the system files and perform update operations such as add, change, and delete. The following example illustrates how to update the "Technical Fields" file.

Example 3. Update the "Technical Fields" file

The system supervisor should use the password for accessing the "Database" menu.

(a) Choose "Technical Field" from the "Database" menu. The records stored in this system file will be retrieved and displayed in a dialog box as shown in figure 9. Click the Retrieve button to see the next record.

(b) To change certain fields of a record, simply enter the new contents in the "New Value" box and click the Change button (see figure 10).

(c) To insert a new record, enter all the new fields in the "New Value" box and click the Add button (see figure 11).
(a) Choose "Technical Field"

(b) File information about a technical area

Figure 9. Retrieving a Record in the Technical Fields File
<table>
<thead>
<tr>
<th>Technical Field Information</th>
<th>Current Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Area</td>
<td>Kinematics</td>
<td>Kinematics</td>
</tr>
<tr>
<td>Article Area</td>
<td>Kinematics</td>
<td>Kinematics</td>
</tr>
<tr>
<td>First Index</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Last Index</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>Child Nodes</td>
<td>Nil</td>
<td></td>
</tr>
<tr>
<td>Parent Node</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Figure 10. Modifying a Record in the Technical Fields File
<table>
<thead>
<tr>
<th>Technical Field Information</th>
<th>Current Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Area</td>
<td>Kinetics</td>
<td>情報管理</td>
</tr>
<tr>
<td>Article Area</td>
<td>Kinetics</td>
<td>情報管理</td>
</tr>
<tr>
<td>First Index</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Last Index</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>Child Nodes</td>
<td>Nil</td>
<td></td>
</tr>
<tr>
<td>Parent Node</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Figure 11. Inserting a New Record into the Technical Fields File
CHAPTER III - NIHONGO TUTOR USER’S GUIDE

The Nihongo Tutor is an application designed primarily to assist the user in studying a technical article. The tutor keeps track of all the requests invoked by the user in order to give appropriate information and to update his personal database that reflects his current Japanese competence. In addition, the tutor offers supplemental functions such as text editing facilities. In summary, the tutor allows the user to do the following:

- obtain information (meaning, structure, and pronunciation) about Japanese text while studying an article
- access on-line electronic dictionaries
- edit text in Japanese or English

There are two modes of operation offered by the tutor: the “Learn Text” mode and the “Edit” mode. The first one, which is the standard mode of the tutor, should be used by the user to get translation information while studying an article. The second mode is available to the user in order to transform the tutor into a basic word processor.
3.1 Overview

The Nihongo Tutor functions are divided into six menus and three sub-menus. The main menus are as follows:

**Apple Menu.** The apple menu allows the user to select one of the standard desk accessories available from the Macintosh system.

**File Menu.** The file menu allows the user to do standard file input and output such as opening and saving text files. Normally the user does not have to open a document himself since the tutor will properly retrieve the article assigned to him by the Administrator. The commands that this menu contains are:

— New

Get a new (and empty), untitled document.

Note: The user has to save the old contents of the text window in order to keep it; otherwise the old contents are irrecoverably removed.

— Open

Open a previously saved text file and put the contents of the file into the text window.

Note: Under the “Learn Text” mode, when the tutor retrieves an article for the user to study, it also loads up an associated translation file that keeps all the translation information about that article. If the translation file is not found, the translation facilities in the “Functions” menu will be disabled. The old contents of the text window are irrecoverably disposed.

— Save

Save the contents of the currently selected window as a text document.
— Save As

Save the contents of the currently selected window to a user-defined file name.

— Revert

Revert the contents of the text window to the last saved version.

— Page Setup

Set up the style for printing.

— Print

Print the text contents of the currently selected window.

Note: The font type must be either “Kyoto” or “Osaka” for the proper printing of Japanese text by the printer.

Edit Menu. The edit menu allows the user to do standard text editing. The text window is the only window that can be edited. The editing facilities are available under the “Edit” mode (and disabled under the “Learn Text” mode). The commands that this menu contains are:

— Undo

Undo the last action.

Note: Undo is not implemented in the current version.

— Standard Editing Facilities

Cut, Copy, Paste, Clear and Select All.

— Find What

Specify a target string for searching and a replacement string for substitution.
— Find

Find the first occurrence of the target string (as defined by the “Find What” command) in the active, frontmost window starting from the current insertion point.

Note: The searching is not wraparound i.e. it stops searching once it hits the end of the text.

— Replace

Replace some selected text by the replacement string (as defined by the “Find What” command) in the active window.

**Functions Menu.** The functions menu provides the user with useful translation facilities to assist the user in studying an article. The translation facilities are available under the “Learn Text” mode (and disabled under the “Edit” mode). The commands that this menu contains are:

— Edit

Activate the “Edit” mode by enabling the editing facilities (and disabling the translation facilities). This command puts the tutor into a mode in which it can be used to edit a text file.

Note: The text window must be the active window.

— Learn Text

Activate the “Learn Text” mode by enabling the translation facilities (and disabling the editing facilities). This command puts the tutor into a mode in which it can be used to assist the user in studying a technical article.

— Translation

Display information in the translation window about the meaning (and possibly pronunciation) of any highlighted text.
— Full Translation

Display information in the translation window about the meaning (and possibly pronunciation) of all the constituents of any highlighted text.

Note: If the user double-clicks on any portion of a sentence, the system will highlight the basic phrase under the mouse. Further double-clicking will highlight the next grammatical structure that encloses the highlighted text.

— Character Information

Display information in the dictionary window about the meanings and associated pronunciations of any highlighted Kanji.

Note: This command is available only if the Character dictionary is the current dictionary.

— Search Dictionary

Search one of the electronic dictionaries by one of the following keys: Kanji, Katakana, Hiragana, Nelson’s dictionary reference number, radical number, stroke count, or English translation. If the search is successful, all relevant information will be displayed in the dictionary window.

— Radical Information

Display a list of radicals with their associated radical numbers.

— Font

Display a list of available font types in the “Font Type” submenu.

Note: All three windows display the same font type.
— Size
Display a list of available font sizes in the “Font Size” sub-menu.

Note: All three windows display the same font size.

Dictionary Menu. The dictionary menu allows the user to select an electronic dictionary to be used by the “Search Dictionary” command. The dictionaries available are a Kanji character dictionary, a Kanji compound dictionary, a list of specialty dictionaries and a Grammar dictionary. The commands that this menu contains are:

— Character Dictionary
Select the Character dictionary as the current dictionary.

— Compound Dictionary
Select the Kanji Compound dictionary as the current dictionary.

— Specialty Dictionary
Display the list of specialty dictionaries in the “Specialty Dictionary” sub-menu.

Note: Any specialty dictionary selected in the “Specialty Dictionary” sub-menu will be set to be the current dictionary.

— Grammar Dictionary
Select the Grammar dictionary as the current dictionary.

Windows Menu. The user can select one of three windows to be the active, frontmost window by using commands available from the window menu. The text window displays the contents of an article whereas the translation window shows the translation information
associated with that article. The dictionary window presents the information available from the electronic dictionaries. The commands that this menu contains are:

— Text

Select the text window as the active window.

— Translation

Select the translation window as the active window.

— Dictionary

Select the dictionary window as the active window.
3.2 Text Editing

Under the “Edit” mode, all the editing facilities are enabled in the “Edit” menu whereas the translation facilities are disabled. A typical editing session would consist of the following:

— choosing the “Edit” command from the “Functions” menu,

— choosing the “Open” command from the “File” menu to open an old document, or choosing the “New” command from the “File” menu to create a new document,

— entering text (see the KanjiTalk manual) into the text window, and possibly using the standard editing facilities such as cut, copy, paste, etc, from the “Edit” menu,

— saving the contents of the text window in a text file by using either the “Save” or “Save As” command from the “File” menu after all editing work is completed.
3.3 Text Display

The text contents of a file can be displayed in the windows with different font types and sizes. However, for the proper display of Japanese text, the user must choose either the “Kyoto” font or the “Osaka” font.

The following example shows how to set the text to be displayed in “Kyoto” font with 24-point size.

**Font Type.** Select “Kyoto” from the “Font Type” sub-menu to get a new text display (see figure 12).

**Font Size.** Select “24” from the “Font Size” sub-menu to get a new text display (see figure 13).
Figure 12. An Example of Selecting a Font Type
(a) Select font size

(b) New font size

Figure 13. An Example of Selecting a Font Size
3.4 Text Comprehension

When a student logs on to the Nihongo Tutor, he must provide his user name so that the tutor can retrieve the article assigned by the Administrator as his lesson. Once the tutor succeeds in finding this article, the text contents will be displayed in the text window (see figure 14).

If the student has difficulty with some Japanese text in the technical article, the tutor will assist him by offering useful information such as English translations, pronunciations, electronic dictionaries, syntactic analysis, etc. The following commands provide information at different levels:

**Translation.** Highlight text in the text window and choose “Translation” from the “Functions” menu to get information about the entire selected text (see figure 15).

**Full Translation.** Highlight text in the text window and choose “Full Translation” from the “Functions” menu to get information about all the constituents of the selected text (see figure 16). This command provides syntactic analysis about a Japanese clause by showing information (such as meaning, word boundary, etc) about each of its individual constituents.

If the user double-clicks on any portion of a sentence, the system will highlight the word under the mouse. Further double-clicking will highlight the next grammatical structure that encloses the highlighted text (see figure 17). This facility provides another method of obtaining word boundary and structural information for a sentence.
Figure 14. Retrieving the Article Assigned to a Student
(a) Select the Translate command

(b) Translation information

Figure 15. An Example of Translation
(a) Select the Full Translate command

File Edit Functions Dictionary Windows

Kinetics

Translation

速度というのは速さと向きで表わされるものである。物体が一定の速度を動いた距離を速度という。したがって、速度は、あるいは、速度を表す。このように、速度が一定の運動を等速度運動、また

(b) Translation information about all the constituents of the selected text

Figure 16. An Example of Full Translation
Figure 17. An Example of Double-Clicking
Character Information. Highlight a Kanji in the text window and choose "Character Info" from the "Functions" menu to get information about the Kanji from the Character dictionary. As shown in figure 18, the information from the dictionary includes three numbers which are the Andrew Nelson's character dictionary reference number, the radical number and the stroke count for the Kanji respectively, followed by the kun and on readings with associated meanings.

Note: Only one character can be highlighted and it must be a Kanji. The current dictionary must be the Character dictionary.
(a) Select the Character Info command

(b) Character Information

Figure 18. An Example of Getting Character Information
3.5 Electronic Dictionaries

The electronic dictionaries provide the user with general definitions (and possibly pronunciations) about Japanese text or characters. Since each electronic dictionary contains different information, the user must select the correct dictionary before requesting information. The following describes how to use different search commands to obtain information from various electronic dictionaries:

Character Dictionary. Choose “Character” from the “Dictionary” menu to select the Character dictionary (which contains the list of Jōyō Kanji) as the current dictionary and then use one of the following search keys from the “Search Dictionary” sub-menu:

— Kanji

Choose “Kanji” when either the Kanji is already displayed in any one of the three windows or the Kanji can be entered from the keyboard (by providing its readings). Enter the Kanji into the search box and hit the Ok button (see figure 19). Information about the Kanji will then be displayed from the dictionary.

— Kana (Katakana or Hiragana)

Choose “Katakana” or “Hiragana” when the readings of a Kanji are known. The “Katakana” command is used for entering the on readings of the Kanji whereas the “Hiragana” command is used for its kun readings. Enter the reading into the search box and hit the Ok button (see figure 20). Information about the Kanji will then be displayed from the dictionary.
(a) Select the Kanji option

(b) Enter the Kanji

File Edit Functions Dictionary Windows

Dictionary

速 ==> Number = 4700 Radical = 162 Strokes = 10
ソク、はや（い）、すみ（やか）fast, quick, prompt
はや（める）quicken, accelerate

(c) Character information

Figure 19. An Example of Searching the Character Dictionary by a Kanji
Please enter a string of characters:

ソク

Cancel

(a) Enter an "On" reading (in Katakana)

File Edit Functions Dictionary Windows

Dictionary

速 ➞ Number = 4700 Radical = 162 Strokes = 10
ソク、はや（い）、すみ（やか）fast, quick, prompt
はや（める）quicken, accelerate

(b) Character Information

Figure 20. An Example of Searching the Character Dictionary by Readings
— Nelson’s Dictionary Reference Number

Choose “Nelson Dictionary” when the Nelson’s Dictionary reference number of a Kanji is known. Enter the reference number into the search box and hit the Ok button (see figure 21). Information about the Kanji will then be displayed from the dictionary.

— Radical Number

Choose “Radicals” to search for all Kanji categorized under a radical number. Enter the radical number into the search box and hit the Ok button (see figure 22). Information about all Kanji with the same radical number will then be displayed from the dictionary. More information about any desired Kanji in the list can be obtained by highlighting the Kanji and then using the search by “Kanji” function.

Note: Choose “Radical Info” from the “Functions” menu if you need help with a radical number.

— Stroke Counts

Choose “Stroke Count” to search for all Kanji categorized under a particular stroke count. Enter the stroke count into the search box and hit the Ok button (see figure 23). Information about all Kanji with the same stroke count will then be displayed from the dictionary. More information about any desired Kanji in the list can be obtained by highlighting the Kanji and then using the search by “Kanji” function.

— English Translation

Choose “English” to search for all Kanji that include a particular English meaning. Enter the English text into the search box and hit the Ok button (see figure 24). Information about all Kanji containing the same English text will then be displayed from the dictionary.
(a) Enter a Nelson’s Dictionary reference number

![Image of a Nelson’s Dictionary Reference Number dialog box]

File Edit Functions Dictionary Windows

The following character(s) conform with Nelson’s Dictionary reference number = 1511:

度

度 → Number = 1511 Radical = 53 Strokes = 9
degree, measure, limit; times

(b) Character Information

Figure 21. An Example of Searching the Character Dictionary by a Nelson’s Dictionary Reference Number
Please enter a radical number (1 - 220):

53

(a) Enter the radical number

File  Edit  Functions  Dictionary  Windows

The following character(s) conform with radical number = 53:
応 庇 広 康 座 畜 序 床 席 厅 庭 店 度 唐 廟 府 廉 廊

(b) All Jōyō Kanji with the same radical number

Figure 22. An Example of Searching the Character Dictionary by a Radical Number
(a) Enter the stroke count

(b) All the Jōyō Kanji with the same stroke count

Figure 23. An Example of Searching the Character Dictionary by a Stroke Count
Please enter a string of characters:
accelerate

(a) Enter some English text

File Edit Functions Dictionary Windows

The following phrase(s) has meaning related to accelerate:
速 => Number = 4700 Radical = 162 Strokes = 10
ソク、はや（い）、すみ（やか）fast, quick, prompt
はや（める）quicken, accelerate

(b) Character information containing the same English text

Figure 24. An Example of Searching the Character Dictionary by English Translation
Kanji Compound Dictionary. Choose “Compound” from the “Dictionary” menu to select the Compound dictionary (which currently contains 1,000 of the most frequently occurring Kanji compounds) as the current dictionary. The dictionary can be searched by entering some Kanji, a Hiragana reading or any English translation. As shown in figure 25, if only one Kanji character is entered, all relevant Kanji compounds containing this Kanji will be displayed from the Compound dictionary with their associated meanings and readings.

Specialty Dictionary. Choose “Communications” from the “Specialty Dictionary” sub-menu to select the Communications dictionary as the current dictionary. The Communications dictionary can be searched by entering Kanji, a Katakana or Hiragana phrase, or any English translation. In response to some entered characters, all relevant entries containing these characters will be displayed from the Specialty dictionary (see figure 26).

Grammar Dictionary. Choose “Grammar” from the “Dictionary” menu to select the Grammar dictionary as the current dictionary. The Grammar dictionary can be searched by entering some Kanji, a Hiragana phrase, or any English translation.

If a complete grammatical structure is entered, the first entry of this structure in the Grammar dictionary will be displayed (see figure 27). The displayed information includes possible English translations, and a general description of this grammatical structure followed by examples of its usage. The “More Example” button should be clicked by the user if he wants to see the next example. To get the next entry in the Grammar dictionary about the same structure, the user should click the “Next” button (see figure 28). When the user finishes studying the structure, he should click the “Ok” button.
Please enter a string of Kanji:

(a) Select the Compound dictionary

(b) Enter a Kanji

(c) All Kanji compounds containing the same Kanji

Figure 25. An Example of Searching the Compound Dictionary by a Kanji
(a) Select the special Communications dictionary

Please enter a string of characters:

satellite communication

Cancel

(b) Enter some English text

The following phrase(s) has meaning related to satellite communication:

"fixed satellite communication","固定衛星通信"
"mobile satellite communication","移動衛星通信"
"multi beam mobile satellite communication","マルチビーム移動衛星通信"
"multi beam satellite communication","マルチビーム衛星通信"
"phased satellite communication system","位相衛星方式"
"single beam satellite communication","シングルビーム衛星通信"
"stationary satellite communication system","静止衛星方式"
"transponder for multi-beam satellite communication","マルチビーム衛星通信用トランスポンダ"
"transportable earth station for satellite communication","衛星通信用車載局"

(c) All entries* containing the same English text

* The information in this figure is provided courtesy of the Nippon Telegraph and Telephone Corporation

Figure 26. An Example of Searching the Specialty Dictionary for an English Text String
(a) Select the Grammar dictionary

(b) Enter the full grammatical structure

(c) Information* about the grammatical structure

* The information in this figure is extracted from
A Dictionary of Basic Japanese Grammar by Makino and Tsutsui

Figure 27. An Example of Searching the Grammar Dictionary by a Complete Grammatical Structure
### Grammar Information

<table>
<thead>
<tr>
<th>Japanese phrase: いる</th>
<th>English descriptions:</th>
</tr>
</thead>
</table>
| be; exist; stay     | An animate thing exists.

#### Example of usage:

<table>
<thead>
<tr>
<th>Japanese</th>
<th>Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>いる</td>
<td>Lee is in this dorm.</td>
</tr>
</tbody>
</table>

(a) Hit the Next button to get more information

---

<table>
<thead>
<tr>
<th>Japanese phrase: いる</th>
<th>English descriptions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>be -ing; have done something</td>
<td>Someone or something is doing something he or it started some time ago, or</td>
</tr>
</tbody>
</table>

#### Example of usage:

<table>
<thead>
<tr>
<th>Japanese</th>
<th>Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>いる</td>
<td>Mr. Sasaki is drinking sake.</td>
</tr>
</tbody>
</table>

(b) Hit the Ok button to finish

---

* The information in this figure is extracted from *A Dictionary of Basic Japanese Grammar* by Makino and Tsutsui

Figure 28. Requesting More Examples for a Grammatical Structure
The Grammar dictionary can also be searched for all entries which contain a partial Japanese text string (see figure 29). All entries in the Grammar dictionary containing this partial text string will then be displayed.
Please enter a string of characters:

(a) Enter the partial grammatical structure

Grammar Information

Japanese phrase: ばかり
English translations: only; just; be ready to do something;

English descriptions: A particle which indicates that something is the only thing or state which exists,

Example of usage:
Japanese デザートは食べるばかりになっているいます。
Translation The dessert is ready to eat.

(b) Information* about this grammatical structure

* The information in this figure is extracted from
A Dictionary of Basic Japanese Grammar by Makino and Tsutsui

Figure 29. An Example of Searching the Grammar Dictionary for All Entires Including the Partial Text
CHAPTER IV - PARSE TREE EDITOR USER'S GUIDE

The Parse Tree Editor is an application designed to assist the user in preparing technical articles for the Nihongo tutorial system. The editor incorporates important translation information about a technical article into an internal format that can be used by the tutor. In summary, the functions of the editor are as follows:

- build up the translation file (parse tree) of an article
- obtain information from a translation file
- modify the translation information of an article
- edit text in Japanese or English

There are two modes of operation available: the "Auto Setup" mode and the "Manual Setup" mode. The "Auto Setup" mode provides the maximum amount of assistance from the editor and should be considered to be the standard mode. The "Manual Setup" mode allows the more sophisticated user to modify the translation information of an article under certain circumstances.

The primary function of the editor is to "setup parse tree". However, it offers additional functions such as "editing" for inputting and modifying text. For instance, the user can use the editing facilities of the editor to create a document and then apply the parse tree facilities to construct parse trees for each sentence in the article.

The following sections give descriptions of the functions of the Parse Tree Editor as well as some examples for illustration. Notes are given at points that need special attention. Warnings are given when a particular action may require caution.
4.1 Overview

The Parse Tree Editor provides the user with functions that are divided into six menus and six sub-menus and two modes of operation. The main menus are as follows:

**Apple Menu.** The apple menu allows the user to select one of the standard desk accessories available from the Macintosh system.

**File Menu.** The file menu allows the user to do standard file input and output such as opening and saving text files. The commands that this menu contains are:

— **New**

Get a new (and empty), untitled document.

Note: The user has to save the old contents of the text window in order to keep it; otherwise the old contents are irrecoverably removed.

— **Open**

Open a previously saved text file and put the contents of the file into the text window.

Note: Under the "Setup Parse Tree" function, when the editor opens a text file, it also loads up an associated translation file that keeps all the translation information about that article. There will be warnings if no such translation file is found. The old contents of the text window are irrecoverably removed.

— **Save**

Save the contents of the currently selected window as a text document.

Note: The contents of the text window and data window will be saved as a text document whereas those of the
parse tree window are saved as a MacPaint picture. If the picture of a parse tree has to be saved, only the full size of the screen can be stored in a file.

— Save As

Save the contents of the currently selected window with a user-defined file name.

— Revert

Revert the contents of the text window to the last saved version.

— Page Setup

Set up the style for printing.

— Print

Print the contents of the currently selected text or data window.

Note: The font type must be either “Kyoto” or “Osaka” for the proper printing of Japanese text by the printer.

Edit Menu. The edit menu allows the user to do standard text editing. The text window is the only window that can be edited. The editing facilities are available under the “Edit” function (and disabled under the “Setup Parse Tree” function). The commands that this menu contains are:

— Undo

Undo the last action.

Note: Undo is not implemented in the current version.

— Standard Editing Facilities

Cut, Copy, Paste, Clear and Select All.
— Find What

Specify a target string for searching and a replacement string for substitution.

— Find

Find the first occurrence of the target string (as defined by the “Find What” command) in the text or data window starting from the current insertion point.

Note: The searching is not wraparound i.e. it stops searching once it hits the end of the text.

— Replace

Replace some selected text by the replacement string (as defined by the “Find What” command) in the active window.

Functions Menu. The functions menu provides the user with useful facilities for constructing or modifying a parse tree. Some commands may be disabled under the "Auto Setup" mode. The commands that this menu contains are:

— Edit

Activate the “Edit” mode by enabling the editing facilities (and disabling the parse tree facilities). This command puts the editor into a mode in which it can be used to edit a text file.

Note: The text window must be the active window.

— Setup Parse Tree

Activate the “Setup Parse Tree” mode by enabling the parse tree facilities (and disabling the editing facilities). This command puts the editor into a mode in which it can be used to construct parse trees.
— Build

The "Build" sub-menu offers commands to configure or modify a parse tree, and to transform the translation information of an article into an internal data format. A typical user does not need to use any commands in this sub-menu except when he wants to manually build or change a parse tree. The sub-menu displays the following commands:

(a) Parse Tree

Construct the configuration of a parse tree by defining the leaf nodes (the basic building blocks), and joining these nodes together in the parse tree window (see the "Operation" menu).

(b) Data

Transfer the translation information of an article into an internal format to be displayed in the data window.

(c) Node

Create an additional node (which is displayed in the parse tree window that shows all the nodes) in the parse tree of the last sentence just processed. This command should only be used under exceptional circumstances.

Note: The "Build Parse Tree" and "Build Node" commands are available under the "Manual Setup" mode (and disabled under the "Auto Setup" mode).

— Translation

The "Translation" sub-menu allows the user to provide English translations for a sentence as well as a node. The user should choose the "Sentence Translation" command if he wants to start constructing the parse tree. This menu displays the following commands:
(a) Sentence

Allow the user to provide the English translation of a sentence highlighted in the text window.

Note: In the "Auto Setup" mode, this command automatically calls upon the "Build Parse Tree" command to configure the parse tree.

(b) Node

Allow the user to provide the English translation and Japanese reading of a node highlighted in the text window.

Note: This command is only available in the "Manual Setup" mode.

Information

The "Information" sub-menu provides useful commands to allow the user to obtain the translation information about an article at different levels: a sentence, a parse tree, or a node. The sub-menu displays the following commands:

(a) Parse Tree

Display the configuration of a parse tree in the parse tree window.

(b) Sentence

Display the translation information of a sentence.

(c) Node

Display the translation information of a node.

Note: These commands may not be used to modify any translation information.
Check Node

The "Check" sub-menu allows the user to apply supplemental checking routines on the structure of a parse tree. A typical user does not need to use the commands in this sub-menu except when he wants to ensure that a parse tree is properly configured. The sub-menu displays the following command:

Node

Access a node by a special method which is the combination of its sentence identification number and node identification number. The correct procedure to access a node is to highlight its text in the text window. However, since each node is assigned a unique node number within a sentence, the combination of the sentence and node numbers provides another method to access a node.

Note: This command is only available in the "Manual Setup" mode. It should only be used under exceptional circumstances.

Font

Display a list of available font types in the "Font Type" sub-menu.

Size

Display a list of available font sizes in the "Font Size" sub-menu.

Operation Menu. The "Operation" menu offers two sets of functions. The first set allows the user to specify the mode of operation whereas the second set is the "Join Nodes" facilities that are used to join nodes together while the user is configuring a parse tree. The "Join Nodes" facilities are only enabled when the user is configuring a parse tree. The commands that this menu contains are:
— Auto Setup

Activate the "Auto Setup" mode so that the editor provides the maximum amount of assistance to the user. This mode should always be selected to be the standard mode while constructing parse trees.

— Manual Setup

Activate the "Manual Setup" mode to allow the user to change translation information about an article. This command enables certain useful commands in the "Functions" menu that are used to modify translation information.

— Join Nodes

Create a new node (the parent node) in the parse tree window and connect it to the highlighted nodes (the child nodes).

Note: Most of the commands in the "Functions" menu are disabled until the "Join Nodes" operation is completed.

— Join Nodes Done

Inform the editor that the "Join Nodes" operation has been completed.

Note: In the "Auto Setup" mode, this command automatically calls upon the "Node Translation" command to get the translation information for each node.

Windows Menu. The user can select one of three windows to be the active, frontmost window by using commands available from the window menu. The text window displays the contents of an article whereas the parse tree window shows the configuration of the parse tree pertaining to the currently selected sentence. The data window presents the translation information about the article. The commands that this menu contains are:
— Text

Select the text window as the active window.

Note: If the user double-clicks on any portion of a sentence, the editor will highlight the basic phrase under the mouse. Further double-clicking will highlight the next grammatical structure that encloses the highlighted text.

— Parse Tree

Select the parse tree window as the active window.

Note: If the user double-clicks on the rectangular box of a node, the editor will bring up a dialog box showing the translation information of that node.

— Data

Select the data window as the active window.
4.2 Text Editing

Under the "Edit" mode, all the editing facilities are enabled in the "Edit" menu whereas the translation facilities are disabled. A typical editing session would consist of the following:

— choosing the "Edit" command from the "Functions" menu,

— choosing the "Open" command from the "File" menu to open an old document, or choosing the "New" command from the "File" menu to create a new document,

— entering text (see the KanjiTalk manual) into the text window, and possibly using the standard editing facilities such as cut, copy, paste, etc, from the "Edit" menu,

— saving the contents of the text window in a text file by using either the "Save" or "Save As" command from the "File" menu after all editing work is completed.
4.3 Text Display

The text contents of a file can be displayed in the windows with different font types and sizes. The user should choose the font type that he wants from the "Font Type" sub-menu and select the best font size from the "Font Size" sub-menu. Any change in the font type or size affects only the text and data windows; the parse tree window is not affected.

Note: For the proper display of Japanese text, the font type must be set to be either the "Kyoto" font or the "Osaka" font.
4.4 Constructing a Parse Tree

There are two modes of operation that the user can use while constructing the parse tree of a sentence. The "Auto Setup" mode, which is the standard mode, provides the maximum amount of assistance from the editor. The "Manual Setup" mode provides the user with considerable flexibility in modifying selected portions of a parse tree, however it should only be invoked by experienced users.

To construct the parse trees for an article in the "Auto Setup" mode, the following procedure should be followed:

- highlight the boundary of a sentence and choose the “Sentence Translation” command from the “Functions” menu to provide an English translation for the entire sentence,

- highlight the boundary of each leaf node (basic block) of the sentence,

Note: Under the “Manual Setup” mode, the user would select the “Build Parse Tree” command from the “Build” sub-menu to invoke this step.

- highlight all sibling nodes and choose the “Join Nodes” command from the “Operation” menu to join the nodes together to form parent nodes,

- choose the “Join Nodes Done” command from the “Operation” menu when the “Join Node” operation has been completed,

- provide translations for each node,

Note: Under the “Manual Setup” mode, the user would select the “Node Translation” command from the “Translation” sub-menu to invoke this step.

- choose the “Save” command from the “File” menu in order to keep the contents of the data window (which captures all of the translation information of each parse tree) in a translation file.
Note: The file name of the translation file will be the article name in the text window followed by the ".tr" extension.

The above steps are repeated for each sentence until the entire article is processed. The user must save any partial work if he wants to finish the rest of the process later. If something wrong has been done while constructing a parse tree, such as providing the wrong English translation or joining the wrong nodes together, the user can use the "Manual Setup" mode to correct the errors. However, if there are more serious problems like the partitioning of leaf nodes is not correct, it is simpler to restart the process from the first step. To test whether the translation information of an article is correct or not, the user can use the commands available in the "Information" sub-menu.

Note: Remember to save the translation information in the data window occasionally.

Warning: Each sentence must be processed in sequence, i.e. process the first sentence, then the second sentence, and so on. In a sentence, all single text characters, including any punctuation marks, all embedded spaces, carriage return, etc, must belong to a node. The translation for all punctuation marks must be included as well. The tutor will not function properly if any characters in an article are left unprocessed.

The following example describes the steps required to build up a parse tree for a single sentence in the "Auto Setup" mode.

Example 1. Constructing a Parse Tree

The system must be in the "Auto Setup" mode.

(a) Highlight the sentence and choose "Sentence Translation" from the "Translation" sub-menu. A sentence dialog box will appear. The user should type in the English translation
for the entire sentence in the actual translation box. Then click the OK button (see figure 30).

(b) The leaf node dialog box will now appear. The user should highlight the next basic node of the sentence and click the OK button. This step allows the user to identify the word boundaries of the sentence. The node just highlighted will be removed for processing (see figure 31). Repeat this procedure until the entire sentence has been processed.

(c) The parse tree window will then become the frontmost window with all leaf nodes aligned in the left margin. Highlight all sibling nodes and choose "Join Nodes" from the "Operation" menu. A parent node will be created having the highlighted nodes as children. Keep joining the nodes until the structure of the parse tree has been completed. Choose "Join Nodes Done" when it is finished (see figure 32).

(d) The system then prompts the user for translation information of each node in the node dialog box. The suggested translation box displays the information provided by the user during the last construction (or possibly any relevant information provided by a machine assisted translator in future implementations). Enter the English translation in the actual translation box and then click the Next button. Also enter the pronunciation information if the node is a leaf node containing at least one Kanji (see figure 33). Keep providing translation information until all nodes have been processed.

(e) The translation information for the entire sentence will now be displayed in the data window. The contents of the data window are represented in a special internal format so that the typical user does not need to be concerned
(a) Highlight a sentence and Choose "Sentence Translation"

(b) Provide sentence translation

Figure 30. An Example of Constructing a Parse Tree
Figure 31. An Example of Defining the Basic Leaf Nodes
(a) Select leaf nodes and Choose "Join Nodes"

(b) A new parent node created

(c) Finish joining nodes

Figure 32. An Example of Performing the Join Nodes Operation
(a) Provide node translation

(b) Provide node pronunciation

Figure 33. An Example of Providing Node Translation Information
about the details of the data window. At this point it is a good idea to save this data.

Repeat the above steps for each sentence until the entire article is processed.
4.5 Retrieving Information

The parse tree editor allows the user to examine all of the translation information of a sentence by using the commands available in the "Information" sub-menu. The user is also able to visualize the configuration of a parse tree as well as the translation information pertaining to a sentence or a node. These facilities help the user to make sure that the translation information of an article is correct.

**Sentence.** Highlight the sentence in the text window and choose "Sentence Information" from the "Information" sub-menu. A sentence dialog box will then appear showing all the translation information of the sentence (see figure 34). Click the Next button to know more about the text information stored in the current sentence. Click the OK button when finished.

**Parse Tree.** Highlight the sentence in the text window and choose "Parse Tree Information" from the "Information" sub-menu. The parse tree of the sentence will be displayed in the parse tree window (see figure 35).

**Node.** Highlight a node in the text window and choose "Node Information" from the "Information" sub-menu. A node dialog box will appear showing all the relevant information of the node (see figure 36).

Note: The user can double-click on the rectangular box of a node in the parse tree window to get the same node information.
(a) Highlight a sentence and Choose "Sentence Information"

(b) The sentence information

Figure 34. An Example of Retrieving Sentence Information
(a) Highlight a sentence and Choose "Parse Tree Information"

(b) The parse tree information

Figure 35. An Example of Retrieving Parse Tree Information
(a) Highlight a node and Choose "Node Information"

Information for node 1 of sentence 1

<table>
<thead>
<tr>
<th>Node ID 1</th>
<th>Parent ID 17</th>
<th>Children ID</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin</td>
</tr>
</tbody>
</table>

**Text**  | 速度  | 0   | 3   | (End) |
**Phrase** | 速度  | 1   | 4   |
**Translation** | velocity | 1   | 8   |
**Pronunciation** | そくど | 65  | 6   |

(b) The node information

Figure 36. An Example of Retrieving Node Information
In addition to these commands, the "Functions" menu provides an additional command to access a node by its sentence identification number and node identification number. This command allows the user to perform special checks to ensure that the structure of a parse tree is properly configured. A typical user does not need to use this command except under unusual circumstances. To use this command, choose "Check Node" from the "Check" sub-menu. Enter the two numbers and click the OK button. The node information dialog box will then appear (see figure 37).

Note: This command depends only on identification numbers to access a node. The user is also able to modify the translation information of the node by using this command.
(a) Choose "Check Node"

(b) Enter the sentence and node identification numbers

(c) The node information

Figure 37. An Example of Retrieving Node Information by Identification Numbers
4.6 Modifying Translation Information

The "Manual Setup" mode allows the user to modify selected translation information of an article. To check whether the translation information is correct, the user can choose the commands from the "Information" sub-menu. The Parse Tree Editor can be used to do the following:

- alter the English translation or Japanese reading of a node
- modify the configuration of a parse tree by changing link connections
- adjust a parse tree by creating new nodes.

The following examples illustrate how to modify translation information in the "Manual Setup" mode.

Example 2. Modify English Translation

The system must be in the "Manual Setup" mode.

(a) Highlight the node in the text window and choose "Node Translation" from the "Translation" sub-menu (see figure 38). Click the Translation button to get the old English translation text in the suggested translation box. Enter the new English translation in the actual translation box and click the OK button (see figure 39). Click the Next button to step through the other translation information such as pronunciation or child nodes.

(b) Choose "Node Information" from the "Information" sub-menu to make sure that the new translation information is correct.
(a) Choose the "Manual Setup" mode

(b) Highlight the node and Choose "Node Translation"

Figure 38. An Example of Modifying the Translation Information of a Node
(a) Change the English translation

(b) Node information shows the update

Figure 39. The Node Translation Information Updated
Example 3. Modify Parse Tree Configuration by Changing Link Connection.

The user should choose the "Manual Setup" mode from the "Operation" menu. Assume that the configuration of a parse tree is to be changed as shown in figure 40. To change the link connection, the following steps should be performed:

(a) Highlight the text of node 1 in the text window and choose "Node Translation" from the "Translation" sub-menu. Click the Parent button to get the old parent link. Change the parent node of node 1 from node 5 to node 6 and click the OK button (see figure 41).

(b) Highlight the text of node 5 in the text window and choose "Node Translation" from the "Translation" sub-menu. Click the Children button to get the old child node list. Remove node 1 from the child node list of node 5 and click the OK button (see figure 42).

Note: The child nodes must be separated by commas.

(c) Highlight the text of node 6 in the text window and choose "Node Translation" from the "Translation" sub-menu. Click the Children button to get the old child node list. Add node 1 to the child node list of node 6 and click the OK button.

The editor will display the new configuration of the parse tree in the parse tree window.
Figure 40. An Example of Modifying a Parse Tree Configuration by Changing Link Connections
Figure 41. An Example of Changing the Parent Link of a Node
Figure 42. An Example of Updating the Child Node Link of a Node
Example 4. Modify Parse Tree Configuration by Creating a New Node.

The user should choose the "Manual Setup" mode from the "Operation" menu. Assume that the configuration of a parse tree is to be changed as shown in figure 43. To create the additional node, which is node 5 in figure 43, the user should choose "Build Node" from the "Build" sub-menu. As shown in figure 44, the new node will be displayed in the parse tree window. The user can create as many extra nodes as he needs if the parse tree belongs to the last processed sentence. To correct the link information, the following steps should be performed:

(a) Highlight the text of node 5 in the text window and choose "Node Translation" from the "Translation" sub-menu. Click the Children button to get the old child node list. Add node 1 to the child node list of node 5.

(b) Choose "Check Node" from the "Check" sub-menu to access node 4. Click the Children button to get the old child node list. Remove node 1 from the child node list of node 4.

(c) Highlight the text of node 1 in the text window and choose "Node Translation" from the "Translation" sub-menu. Click the Parent button to get the old parent link. Change the parent node of node 1 from node 4 to node 5.
Figure 43. An Example of Modifying a Parse Tree Configuration by Creating a New Node
(a) Choose "Build Node"

(b) A new node created

Figure 44. A New Node Created by the Build Node Command